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A quantitative and semiautomated method 
for determining misaligned and lagging 
chromosomes during mitosis

ABSTRACT Accurate chromosome alignment at metaphase facilitates the equal segregation 
of sister chromatids to each of the nascent daughter cells. Lack of proper metaphase align-
ment is an indicator of defective chromosome congression and aberrant kinetochore–micro-
tubule attachments which in turn promotes chromosome missegregation and aneuploidy, 
hallmarks of cancer. Tools to sensitively, accurately, and quantitatively measure chromosome 
alignment at metaphase will facilitate understanding of the contribution of chromosome seg-
regation errors to the development of aneuploidy. In this work, we have developed and vali-
dated a method based on analytical geometry to measure several indicators of chromosome 
misalignment. We generated semiautomated and flexible ImageJ2/Fiji pipelines to quantify 
kinetochore misalignment at metaphase plates as well as lagging chromosomes at anaphase. 
These tools will ultimately allow sensitive and systematic quantitation of these chromosome 
segregation defects in cells undergoing mitosis.

INTRODUCTION
Faithful segregation of chromosomes relies on their accurate align-
ment at the metaphase plate during mitosis (Kuniyasu et al., 2018). 
Errors in this process result in chromosome missegregation and aneu-
ploidy, which is defined as an abnormal number of chromosomes for 
a given cell type or organism. Aneuploidy drives the development of 
cancer, at least in part through promoting chromosomal instability 
(CIN), a state in which the cell displays a high rate of gain and loss of 
whole chromosomes (Weaver et al., 2007; Gordon et al., 2012; 
McGranahan et al., 2012; Storchova, 2018; Soto et al., 2019). CIN is a 

cause of tumor heterogeneity, is associated with poor patient progno-
sis, and has been linked to drug resistance (McGranahan et al., 2012). 
To prevent the emergence of aneuploidy and CIN, eukaryotic cells 
align duplicated sister chromatids at metaphase in a bioriented (also 
known as amphitelic) manner. The process by which chromosomes 
are transported to the spindle equator, known as chromosome con-
gression, is thought to promote mitotic fidelity by ensuring that chro-
mosomes enter anaphase in a spatially coordinated manner, thereby 
preventing random chromosome segregation (Maiato et al., 2017). 
By aligning at the spindle equator, chromosomes are forced to com-
mence separation and the subsequent poleward movement from the 
same relative position. Chromosome alignment also increases the 
likelihood of kinetochore capture by microtubules from both spindle 
poles, thus favoring a bioriented geometry for chromosome attach-
ments (Cheeseman, 2014; Joglekar and Kukreja, 2017; Musacchio 
and Desai, 2017; Hinshaw and Harrison, 2018). Finally, chromosome 
congression promotes correction of erroneous and unstable attach-
ments; proximity to kinase activity at the spindle poles can result in 
phosphorylation at the kinetochore that weakens the interaction with 
spindle microtubules (Barisic et al., 2014; Chmatal et al., 2015; 
Ye et al., 2015). Therefore, chromosome alignment is critical to the 
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fidelity of mitosis, and approaches to systematically and rapidly iden-
tify the degree of chromosome misalignment are required.

Chromosome alignment and congression can be followed using 
live-cell imaging or in fixed samples by indirect immunofluores-
cence. Alignment is typically visually scored in both cases through 
counting displacement of chromosomes from the equator of the 
mitotic spindle. The result is often provided as a binary readout of 
either aligned or misaligned cells. Alternatively, the alignment phe-
notype is subdivided into multiple poorly defined categories. This 
approach is prone to bias and may lack reproducibility as it depends 
on the subjective decision of what constitutes misalignment.

Currently, methods to reliably and reproducibly quantify chromo-
some misalignment and missegregation are limited. One approach 
described by Lampson and Kapoor (2005) measures and normalizes 
the distance of individual kinetochores from the nearest spindle 
pole along the pole–pole axis; while this gives a relative distance for 
individual kinetochores, this method currently lacks automation 
(Lampson and Kapoor, 2005). More recently, Fonseca and Stumpff 
(2016) measured average intensity of each pixel column in the fluo-
rophore channel corresponding to kinetochores along the axis of 
the metaphase plate and along the entire length of the mitotic spin-
dle (Fonseca and Stumpff, 2016). Here, the output is a distribution 
profile comprising the intensities of kinetochores along the mitotic 
spindle. From the Gaussian function fit to this distribution, the full 
width at half maximum (FWHM) is calculated. Each analyzed cell 
provides a single FWHM value that can be used to plot a sigmoidal 
curve comprising the fraction of the cellular population analyzed by 
FWHM. In this manner, statistical comparisons between sigmoidal 
curves reflect the comparisons between different conditions in an 
experiment, giving a global picture of chromosome alignment in the 
conditions examined.

Here, we developed a method based on analytical geometry to 
directly quantify misaligned kinetochores at metaphase and lagging 
chromosomes in anaphase. The method relies on determining the 
position of the two spindle poles, followed by the establishment of 
an alignment region based on segmentation of the area between 
the poles. Kinetochores lying outside a user-defined alignment zone 
are considered misaligned at metaphase and those lying inside as 
lagging in anaphase cells. The same approach was adapted to di-
rectly measure the distance of individual kinetochores away from a 
theoretical metaphase plate. We automated the evaluation of chro-
mosome alignment and lagging chromosomes using a series of 
user-friendly ImageJ2/Fiji macros (freely available at https://github 
.com/Elowesab/elowelab) which can be used to rapidly generate 
quantitative and robust readouts for these mitotic defects.

RESULTS
Cell geometry visualization
To determine chromosome alignment defects, cells were arrested in 
metaphase using approaches previously described in the literature 
(Kapoor et al., 2006; Fonseca and Stumpff, 2016). Briefly, cells were 
synchronized in mitosis using drugs that interfere with microtubule 
dynamics or formation of a bipolar spindle (such as nocodazole, or 
the Eg5 inhibitor S-Trityl-l-Cysteine, STLC). This was followed by re-
lease into media containing the proteasome inhibitor MG132, which 
prevents anaphase onset due to maintenance of high CDK1 activity 
and persistent sister-chromatid cohesion. Chromosomes were al-
lowed to align at the metaphase plate before being fixed and 
stained for kinetochores (using CREST antibodies, or antibodies 
against CENP-C or another kinetochore protein) and spindle poles 
(γ-tubulin or a centrosome marker) as a minimum. To ensure that 
only the population of cells where the spindle and spindle poles are 

found in the same focal plane were sampled, cells were additionally 
stained with α-tubulin to facilitate visualization of the mitotic spindle 
(Figure 1A). Cells with compromised chromosome congression were 
not expected to properly align chromosomes at metaphase, which 
was manifest as a disorganized chromosome mass (visualized by 
DAPI or Hoechst staining) and misaligned kinetochores (marked 
here by CREST, Figure 1A).

Modeling cell geometry
To facilitate modeling of the geometry, cells are spatially translated 
into a Cartesian plane (Figure 1B). This allows mathematical defini-
tion of an alignment zone encompassing the theoretical metaphase 
plate with kinetochores localized outside this region considered un-
aligned (Figure 1C). To achieve this, we developed an approach that 
is broadly divided into three steps: identification of spindle pole 
position, determination of a user-defined alignment zone, and fi-
nally, enumeration of kinetochores outside the defined alignment 
zone.

After the cell of interest is selected, the method relies on two 
main inputs from the user required at the beginning of the opera-
tion. The first is to identify the position of the two spindle poles in 
the image (Figure 1D). The significance of the poles lies in the as-
sumption that a theoretical metaphase plate (represented by the 
metaphase line, green in Figure 1D) is perpendicular to and inter-
sects at the midpoint of the line connecting the two spindle poles 
(the spindle line, yellow in Figure 1D). To this end, (xP1; yP1) and (xP2; 
yP2) represent the coordinates of the first and second spindle poles, 
respectively. Given the two points, the equation of the spindle line 
that passes through both poles and thus the midpoint in between 
the poles can be deduced (Figure 1, E and F). This midpoint repre-
sents the centroid of the alignment zone.

The second user-defined input is a pair of values that are used 
to determine a variable we call the Range. For identifying chromo-
some alignments defects, the Range essentially corresponds to the 
alignment region, which is eventually excluded in order to quantify 
misaligned kinetochores lying outside this zone. Based on the 
premise that metaphase is a polygon centered on the spindle mid-
point (Figure 2A), the user inputs 2 Range parameters, which we 
call the “total segments” and “aligned segments,” to define the 
width of the Range relative to the distance between the poles. 
Here, the value for total segments represents the number of equal 
segments into which the area between the spindle poles is divided, 
whereas aligned segments are the number of central segments en-
compassing the desired Range. In this manner, the line between 
the poles is divided into equal segments, where the segment(s) in 
the middle represent the Range (Figure 2B). The values for both 
Range parameters are arbitrary and user-defined, with some limita-
tion. To ensure that the alignment zone is central, if the spindle 
length is divided into an odd number of segments, the alignment 
zone should also be divided into an odd number of central seg-
ments. In contrast, if the total number of segments is an even num-
ber, the value for aligned segments should also be even. For in-
stance, if the spindle length is divided into five equal segments, the 
narrowest Range can be represented by the single central seg-
ment. A broader metaphase may be desired in which case the 
three central segments would be considered as the alignment 
zone, and the value provided for aligned segments would be 3. 
Likewise, if the spindle line is divided into six equal segments, 
where the four central sections are considered by the user to be the 
alignment region, then the values for total segments are 6, and 4 
for aligned segments (Figure 2B). The choice for the number of 
segments in each category would thus allow for precise definition 
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FIGURE 1: Defining mitotic cells in a Cartesian plane. (A) Representative images of mitotic cells 
with aligned and misaligned chromosomes. HeLa S3 cells were fixed and immunostained with 
CREST serum to mark the kinetochores, γ-tubulin for the spindle poles, and α-tubulin for the 
mitotic spindle. DNA was stained with Hoechst. The degree of misalignment (second and third 
rows) displays a phenotype that is relatively difficult to quantify. Scale bar = 5 µm. (B) A mitotic 
cell represented in a Cartesian plane as a function of x- and y-axes. (C) A cartoon representation 
of the key inputs that are provided by the user: positions of the spindle poles and parameters 
for identifying the alignment zone (Range, red rectangle) around the metaphase line (dashed 
green line). (D) Inferring the metaphase line from the position of the spindle poles. The 
metaphase line is assumed to be perpendicular to the spindle line that passes through the two 
spindle poles. (E) The equation of the spindle line is deduced from the coordinates of the 
spindle poles in the Cartesian plane. Spindle pole centroids are indicated by white circles. 
(F) The midpoint coordinate (green circle) is deduced from the equation of the spindle line.

and calibration of the Range. In this manner a graded or subtle 
alignment defect can be reliably identified. Importantly, the Range 
parameters should remain constant across an experiment to ensure 
equal treatment of the data. After defining pole coordinates and 

setting the Range parameters, the points 
that delimit the alignment region along the 
spindle line (i.e., the width of the alignment 
zone), defined as (x1; y1) and (x2; y2) in the 
Cartesian plane, are calculated as a func-
tion of the Range based on analytical ge-
ometry (Figure 2C; see Materials and 
Methods).

Defining the alignment zone polygon 
in the Cartesian plane
Once the points that delimit the alignment 
zone width along spindle line are deter-
mined, the outer limits of this region are 
defined by establishing the points that de-
limit the rectangular alignment zone cen-
tered at the midpoint (Figure 3A). To do 
this, lines parallel to the metaphase line and 
that pass though (x1; y1) and (x2; y2), de-
fined here as alignment lines, are calculated 
(Figure 3, B and C). The width (W) along the 
spindle line of the rectangle is set by the 
position of the alignment lines, but its 
length (L) is not a function of the spindle, 
and here we set them to incorporate the 
entire cell as metaphase plate dimensions 
can vary (Figure 3D). By applying the end-
points described above to the equations of 
the alignment lines, the four points of the 
rectangle defining the alignment zone are 
obtained (see Materials and Methods). Be-
cause the slope of the spindle line in the 
Cartesian plane can be positive or nega-
tive, the endpoint values on the x- and y-
axes of the plane used to determine the 
limits of the rectangle are set accordingly in 
the macro described below (Figure 3, D 
and E). In sum, our geometrical model of 
the cell requires as minimal inputs by the 
user the coordinates of the spindle poles if 
they are being manually defined and arbi-
trary Range parameters to determine the 
alignment region.

The method described above classifies 
kinetochores as either aligned or mis-
aligned. However, the distance between ki-
netochores and the metaphase line can 
give an alternative readout for chromosome 
alignment (Figure 3F). To measure kineto-
chore distances, the metaphase line is de-
fined as indicated above based on the posi-
tion of the spindle poles. The kinetochores 
are then either manually or automatically 
detected and the shortest distance be-
tween individual kinetochores and the 
metaphase line is computed (see Materials 
and Methods).

Semiautomated ImageJ macro for quantification of 
misaligned chromosomes
To implement and automate the above methods for detection of ki-
netochore misalignment, we created Fiji (ImageJ2) macros to count 



Volume 32 April 19, 2021 Quantifying kinetochore misalignment | 883 

kinetochore misalignment as well as measure distances of individual 
kinetochores away from the metaphase line. The first step of the 
macro for kinetochore misalignment is a prompt for the user to open 
images (single plane or a projected stack) that will be used to identify 
the spindle poles, kinetochores, and the chromatin in that particular 
order, which is predetermined to facilitate automation of the method. 
Next, the user is prompted to select the region/cell of interest (Figure 
4Ai). Signals outside of this region are subsequently excluded to en-
sure that only kinetochores from the cell of interest contribute to the 
final kinetochore count. Once the region of interest (ROI) is selected, 
the user is prompted to set the parameters necessary to determine 
the Range, the number of total segments and aligned segments. The 
y-axis limit, which defines the length of the alignment zone, is set to 
a default 15,000 pixels and can be manually changed if desired, de-
pending on the parameters used for image acquisition (Figure 4Aii). 
The next step is to identify the position of the spindle poles. The user 
is prompted to identify the poles either automatically or manually in 
the appropriate channel (Figure 4Bi). Automatic detection is accom-

plished with the built-in ImageJ function Analyze Particles, as 
indicated in the Materials and Methods (Figure 4Bii), whereas the 
multi-point function is used for manual selection. The position of the 
poles as well as Range parameters are then used to determine the 
alignment zone (Figure 4Ci); the signals inside this zone are deleted 
with the Clear function in the kinetochore image, and only the ob-
jects (misaligned kinetochores) outside the alignment region remain 
(Figure 4Cii). These kinetochores are then counted automatically 
with ImageJ/Fiji built-in functions. The user is prompted to evaluate 
and can manually threshold the remaining signal in the kinetochore 
channel to facilitate accurate quantification of the number of objects 
remaining (Figure 4C, iii and iv).

Measurement of kinetochore distances from the metaphase line 
does not require definition of an alignment zone or Range parame-
ters. Instead, after the poles are identified (either automatically or 
manually) and the metaphase line computed as above (Figure 4, D 
and E), the user is prompted to choose between manual or auto-
matic kinetochore detection (Figure 4F). Once kinetochores are 

FIGURE 2: Identifying chromosome alignment regions as a function of the Range. (A) Scheme depicting the Range and 
the theoretical alignment region as a function of the pole–pole distance. (B) Examples illustrating variations of the Range 
segmentation scheme. The poles are represented by white circles, the midpoint by the green circles, and the points 
delimiting the alignment region are represented by black circles. The poles are used to delimit a line that is divided by 
an arbitrary number, creating several sections. One or more sections are chosen as the aligned sections. (C) Graphical 
representation of the Range relative to the spindle poles and the midpoint. The equations for the calculation of the 
points (x1; y1) and (x2; y2) delimiting the alignment region (the black circles) are shown.
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identified, the distance of each kinetochore 
to the metaphase line is computed (see 
Materials and Methods).

Evaluation of chromosome alignment 
in Aurora B and CENP-E inhibited cells
To generate chromosome misalignments 
and reliably test our pipeline, we took ad-
vantage of the phenotypes associated with 
the inhibition of two key proteins that regu-
late chromosome alignment during mitosis: 
the kinase Aurora B and the kinesin CENP-
E. Aurora B (the catalytic subunit of the 
chromosomal passenger complex) localizes 
mainly to the centromere during early mito-
sis and can phosphorylate multiple targets 
at kinetochore proximal centromeres and 
kinetochores to ultimately regulate the mi-
crotubule–kinetochore interaction status 
(Welburn et al., 2010; Hindriksen et al., 
2017; Lampson and Grishchuk, 2017). 
Moreover, Aurora B activity can destabilize 
kinetochore–microtubule attachments by 
inhibiting protein phosphatases responsi-
ble for stabilizing microtubule binding (Liu 
et al., 2010; Foley et al., 2011; Nijenhuis 
et al., 2014; Meppelink et al., 2015). CENP-
E is a processive plus-end motor protein 
that moves its chromosome cargo along 
spindle microtubules, thereby promoting 
congression to the metaphase plate (Schaar 
et al., 1997; Espeut and Abrieu, 2015; Yu 
et al., 2019). CENP-E is also thought to 
promote the formation of end-on stable 
kinetochore–microtubule attachments to 
maintain chromosome alignment at the 
metaphase plate (Shrestha and Draviam, 
2013). Inhibition or depletion of either 
Aurora B or CENP-E in human cells 
causes alignment defects and lagging 
chromosomes in anaphase (Yen et al., 1991; 
Harborth et al., 2001; Ditchfield et al., 2003; 
Hauf et al., 2003; Tanudji et al., 2004; Cimini 
et al., 2006; Bennett et al., 2015).

To evaluate the sensitivity of the analysis 
pipeline, we used it to determine chromo-
some alignment and metaphase kinetochore 
distances from the metaphase plate in Hela 
S3 cells in which Aurora B or CENP-E were 
inhibited with ZM447439 or GSK923295, re-
spectively, using the lowest working concen-
trations commonly found in the literature 
(See Figure 5A for experimental timeline). 

FIGURE 3: Geometrical model of the chromosome alignment region in a Cartesian plane. 
(A) The alignment region is defined by a polygon centered on the midpoint. (B) The metaphase 
line is perpendicular to the spindle line. The slope of the metaphase plate is deduced from the 
spindle line. (C) Two points (black circles) along the spindle line delimit the width of the 
alignment region. The red alignment lines passing through these points delimit the alignment 
region and are parallel to the metaphase line. As a result, both alignment lines and metaphase 
line have equal slope coefficients. (D) To define a polygon encompassing the alignment zone, 
the width is limited by the alignment lines, and the extremities of the image are used to limit the 
length, ensuring that the whole cell is encompassed. In this configuration, a < 0 and the first 
corner coordinate (xr1; yr1) is defined as the point where the first alignment line crosses the 
y-axis. The second point (xr2; yr2) is the closest point on the second alignment line to (xr1; yr1). 
For the third point (xr3; yr3) a value greater than the image size was considered, and the closest 
point to it in the second alignment line defines the fourth point (xr4; yr4). (E) If the metaphase 
plate has negative slope a > 0, the first coordinate is calculated by the point where the first 
alignment line intercepts the x-axis. A similar rationale to the previous configuration is used to 

find all points delimiting the rectangle. 
(F) Since each kinetochore is separately 
counted in Fiji, their individual position can 
be determined by built-in functions. The 
distance of each kinetochore from the 
theoretical central line in between the poles 
(metaphase line) can then be calculated.
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FIGURE 4: Key steps in the execution of chromosome alignment and kinetochore-metaphase line distance macros. 
(A) (i) The initial step is selection of the ROI in the DAPI/Hoechst channel. Signal outside this selection is deleted from 
the CREST and γ-Tubulin images. (ii) This is followed by selection of the Range parameters. (B) (i) Selection of the spindle 
poles is then initiated in the appropriate channel (here, in the image stained for γ-tubulin). (ii) The spindle poles (red 
triangles) are then detected automatically in Fiji by the built-in function Analyze Particles. The centroid from each area is 
used as pole coordinates for the mathematical operations. (C) (i) The alignment region is delimited by the dotted lines in 
the image corresponding to kinetochores. (ii) In the chromosome alignment macro, the signal inside the selection is 
removed, with only the signal from misaligned kinetochores remaining. (iii) The Threshold function is then used to 
identify the remaining kinetochores. (iv) These are then counted in the macro using Analyze Particles functions. (D) To 
measure kinetochore distance from the metaphase plate, ROI selection occurs in the image corresponding to the 
spindle poles. As in A, signals outside the ROI are deleted in the images corresponding to the poles and kinetochores. 
(E) Spindle poles are detected as in B. (F) All kinetochores (after thresholding) are detected and their distance from the 
metaphase line is computed.

Measurement of the distances of individual kinetochores from the 
metaphase line in cells confirmed an increase in kinetochore dis-
tances from the metaphase line of cells treated with either 0.5 μM 
ZM447439 or 10 nM GSK923295 as expected (Figure 5, B and D). 
Similar conclusions were reached when the mean kinetochore dis-
tance from the metaphase line was calculated for each cell examined 
(Figure 5C).

To test robustness and versatility, we determined kinetochore 
misalignment using 3 variations of the Range, each with progres-
sively increasing width (Figure 5E): (i) 1 aligned segment out of 5, (ii) 
2 aligned segments out of 6, and (iii) 4 aligned segments out of 6. 
As expected, low levels of misaligned chromosomes were observed 
in cells treated with DMSO, while cells treated with either inhibitor 
presented a marked and statistically significant increase in chromo-
some misalignment (Figure 5E) for almost all Range values (see 

below). In addition, the absolute number of misaligned kinetochores 
counted from the same dataset decreased with increasing align-
ment zone (Range) size for all conditions tested (compare the values 
for the same condition among Figure 5E, i–iii). This is as expected, 
given that a wider alignment zone/Range would result in more ki-
netochores being considered as aligned, further validating our ap-
proach. Moreover, the data also confirm that the choice of values for 
the total segments and alignment segments inputted determines 
the extent of misalignment and should be optimized carefully by the 
user. For example, using a Range of 1 out of 5 and 2 out of 6 re-
vealed differences in chromosome misalignment with higher statisti-
cal significance compared with a Range of 4 out of 6 in cells treated 
with either ZM447439 or GSK923295. Once optimized, the Range 
parameters should be maintained throughout the entire analysis of 
any given experiment.
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FIGURE 5: Validation of the chromosome alignment and kinetochore to metaphase line distance operations and 
macros. (A) Experimental timeline for validation of the chromosome alignment kinetochore to metaphase plate distance 
pipelines. (B) Distance of individual kinetochores from the metaphase line in cells treated as indicated. Individual data 
points are shown from three replicate experiments, with 25–142 kinetochores per cell and a minimum of 20 cells 
measured per condition. Large circles represent the means ± SE. Statistical differences were measured by a repeated-
measures one-way ANOVA. Exact P values are shown were determined by a paired t test between control and test 
conditions. (C) Average kinetochore distance per cell for the data in B. Individual data points are shown from three 
replicate experiments, with a minimum of 20 cells per condition. Large circles represent the means ± SE of individual 
experiments and statistical differences were measured by a repeated-measures one-way ANOVA. Exact P values are 
shown. (D) Representative images of the data are shown in B and C. Scale bar = 5 µm. (E) Measurement of kinetochore 
misalignment under the conditions indicated using Range parameters of (i) 1 out of 5, (ii) 2 out of 6, and (iii) 4 out of 6. 
Individual data points are shown from three independent experiments, with a minimum of 25 cells per condition. Large 
circles represent the means ± SE of individual experiments. Statistical differences were measured by a repeated-
measures one-way ANOVA. Exact P values are shown. (F) The number of misaligned kinetochores, (G) kinetochore 
distance from metaphase line, and (H) average kinetochore distance from metaphase line in cells treated with increasing 
doses of the Aurora B inhibitor ZM447439. A range of 4 out of 6 was used for evaluation of the alignment errors. 
Individual data points from two independent experiments are shown, with a minimum of 30 cells per condition. For G, 
25–95 kinetochores were examined per cell. Large circles represent the means ± SD of individual experiments.

To provide further support for the robustness of the method in 
assessing diverse degrees of chromosome alignment, we measured 
the kinetochore distances from metaphase plates and quantified 
chromosome misalignment in cells treated with increasing concen-
trations of ZM447439. Using the macro and selecting the Range ra-
tio of 4 aligned segments out of 6, the average number of mis-
aligned kinetochores increased incrementally with increasing doses 
of ZM447439 until a plateau was reached at 10 μM (Figure 5F). In 
agreement, measurement of kinetochore distances also demon-
strated larger displacement from the metaphase line with increasing 
doses of the Aurora B inhibitor, at the level of individual kineto-
chores as well as individual cells (Figure 5, G and H). Collectively, 
these observations strongly correlate with the effect of these inhibi-
tors on chromosome alignment documented in the literature and 
validate the methodology presented above.

Evaluation of lagging chromosomes
Chromosome lag in anaphase is a well-known consequence of im-
proper kinetochore–microtubule attachments and can result in er-
roneous segregation as well as damage to lagging chromosomes 
trapped in the cleavage furrow or micronuclei (Holland and Cleve-
land, 2012). Quantification of lagging chromosomes usually relies 
on manual counting (Godek and Compton, 2018), which can be 
prone to human error and fatigue. We reasoned that translation of 
the cell into a Cartesian plane and its segmentation can be simply 
and rapidly adapted (and automated in Fiji/ImageJ2) to measure 
lagging chromosomes in anaphase. In this context, instead of using 
the poles to delimit the spindle line, the two anaphase chromosome 
masses are used (Figure 6A). After selecting the ROI, the user is 
again prompted to define the Range as above. Next, the center of 
each chromosome mass in the DAPI/Hoechst image is manually or 
automatically detected (see Materials and Methods). Once these 
anchor points have been defined, the same geometric procedure 
described above is used to delimit the user-defined Range in the 
center, which now represents the ROI for evaluating the number of 
lagging chromosomes and is thus retained, whereas the area out-
side is excluded. To validate this method and the associated macro, 
we treated HeLa S3 cells entering mitosis with ZM447439 to gener-
ate chromosome attachment errors (Figure 6B). Quantification of 
anaphase-lagging chromosomes in control and ZM447439-treated 
cells using the macro and the user-defined segmentation of the area 
between the divided chromosome masses (in this case, a Range of 
3 out of a total of 5) confirmed these observations and demon-
strated a statistically significant difference in the number of lagging 

chromosomes between control and ZM447439-treated cells (Figure 
6, C and D).

DISCUSSION
Here, we used a Cartesian plane model of the cell and analytical 
geometry to facilitate the quantification of misaligned kinetochores 
and anaphase-lagging chromosomes, common mitotic defects that 
are often reported in the literature. Moreover, we have automated 
the operations in a series of user-friendly, flexible macros (https://
github.com/Elowesab/elowelab). We have validated this approach 
and the associated macros using data acquired from cells treated 
with Aurora B and CENP-E inhibitors, both of which have been con-
sistently reported to induce perturbations in chromosome align-
ment at metaphase and segregation at anaphase (Yen et al., 1991; 
Ditchfield et al., 2003; Tanudji et al., 2004; Cimini et al., 2006). Our 
results are fully consistent with the literature and confirm the utility 
of the approach developed here for automated scoring of these 
defects.

In addition to providing an objective quantification of chromo-
some alignment errors, one of the key strengths of this approach is 
the versatility in Range parameters which allows for standardized 
definition of the alignment zone. Range parameters can be tailored 
and optimized by the user to help improve interexperiment varia-
tion, for example. It is important, however, to retain the same Range 
parameters within a single experiment to ensure comparable analy-
sis of control and test conditions. Considering that the Range is a 
constant fraction of spindle length, the inherent variability of differ-
ent cell sizes in a heterogeneous cell population is accounted for in 
the execution of the method. These characteristics, together with 
the semiautomated nature of this methodology, will undoubtedly 
reduce user errors and increase reproducibility.

We show here also that the method is flexible and can be 
adapted to measure lagging chromosome in anaphase (Figure 6), 
an important mitotic defect that is currently only manually curated. 
Furthermore, although limited to images of fixed cells in this manu-
script, this approach can in principle be expanded to analysis of 
video microscopy of cell division; by determining the poles and ki-
netochore positioning in each frame from a live-cell movie, the dy-
namics of kinetochore positioning in relation to a theoretical meta-
phase plate can also be inferred. If the relative position of each 
kinetochore is calculated for each time point, it would be possible to 
evaluate chromosome congression in real time.

One limitation of the approach presented here is that it assumes 
a symmetric spindle with the alignment region centered between 
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the two half-spindles and thus misalignment from severely mal-
formed or asymmetric spindles may not be accurately detected au-
tomatically, although this may still be possible manually. As with any 
other automated or semiautomated image analysis methods, reli-
able immunostaining (of kinetochores and spindle poles in this case) 
are key to generating reproducible results. However, this is coun-
tered by the flexibility offered in detection of the anchor points 
(spindle poles and the anaphase DNA centroids), which in the macro 
can be identified either manually or automatically with built-in Fiji 
functions. This feature may be useful in the absence of pole staining, 
or in cases where poor staining of centrosome or spindle pole mark-
ers in the image makes automatic detection problematic. In this 
case, pole coordinates could be inferred (albeit less precisely) from 
mitotic spindle architecture and positioning using α-tubulin stain-
ing, for example. Moreover, manual selection of kinetochores and 
thresholding at key points during pauses in the operation allow for 

further user optimization, as necessary. In conclusion, the method 
outlined in this study provides a reliable, semiautomated and versa-
tile tool for quantification of chromosome segregation defects in 
mitosis and will serve as a useful tool for researchers in the cell cycle 
and aneuploidy fields.

MATERIALS AND METHODS
Cell culture and immunofluorescence
HeLa S3 cells were cultured in DMEM (Hyclone) supplemented with 
10% (vol/vol) of bovine growth serum and Pen/Strep (100 μg/ml, 
Hyclone) at 37°C and 5% CO2. For measuring chromosome align-
ment, cells seeded onto coverslips were arrested with STLC (Sigma, 
5 μM) for 12 h. Subsequently, cells were released into MG132 
(Calbiochem, 20 μM) for 2.5 h and then fixed with PTEMF (0.2% 
Triton X-100, 20 mM PIPES, pH 6.9, 1 mM MgCl2, 10 mM EGTA, and 
4% formaldehyde). Cells were also treated with either Aurora B 

FIGURE 6: Adaptation and of the Range operations for the measurement of lagging chromosomes. (A) Steps used by 
the macro to count the number of lagging chromosomes. After the desired cell is selected and outside signal deleted, 
the center of each anaphase mass in the chromatin channel is determined using Fiji built-in functions. The lagging region 
is determined as a function of the Range, and signals outside this are excluded in the image corresponding to the 
kinetochores. Kinetochore thresholding and detection then facilitate counts of objects/kinetochores within the zone 
defined by the Range. (B) Experimental timeline for validation of the lagging chromosome macro. (C) Representative 
immunofluorescence images from the experiment outlined in B. Kinetochores from lagging chromosomes are marked 
with yellow arrowheads. Scale bar indicate 5 µm. (D) The number of lagging chromosomes per cell in cells treated as 
indicated. The experiment was assessed with a Range of 3 out 5, which is represented in A. Data points from three 
independent experiments are shown, with a minimum of 20 cells per condition. Large circles represent the means ± SE 
of individual experiments. Statistical significance is tested by the paired t test and exact p values indicated.
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(ZM-447439, Enzo) or CENP-E (GSK923295, Selleckchem, S7090) 
inhibitors at the indicated concentrations for 30 min, before being 
fixed and stained. To measure lagging chromosomes in anaphase, 
cells were arrested for 16 h in G2/M with 4 μM RO-3306 before 
being released for 1.5–2 h into control media or media containing 
ZM447439. Primary antibodies for immunofluorescence were used 
at 1 μg/ml and included CREST anti-Centromere serum (HCT-0100, 
Immunovision), anti-α-Tubulin (DM1A, Santa Cruz), and anti-γ-
Tubulin (T3559, Sigma-Aldrich). Hoechst 33342 (Thermo Scientific) 
was used at 1 mg/ml.

Microscopy
Image acquisition was performed with an Olympus IX80 equipped 
with a WaveFX-Boreal-SC Yokagawa spinning disk confocal (Quo-
rum Technologies) and an Orca Flash4.0 camera (Hamamatsu). 
Metamorph software (Molecular Devices) was used to acquire Z-
stack of 16 images at 0.2-μM intervals that were then projected onto 
a single plane for further processing. Optical sections were acquired 
with identical exposure times for samples within an experiment for 
each given laser.

Macro and image analysis
Image analysis was performed using ImageJ2 (Fiji version 1.52i). The 
initial steps integrated into the macros provided with this article are 
as follows: First, on starting the macro, the user is prompted to open 
the single plane or projected image files of the kinetochore, chro-
mosomes, and/spindle poles in a particular order which is retained 
to facilitate automation. Next, the cell of interest is selected using 
the Oval selection tool, followed by the deletion of signals outside 
the cell with the Edit>Clear outside command. The user is then 
prompted to input the Range parameters: total number of segments 
and aligned segments as well as the y-axis inferior limit. For quanti-
fying the number of misaligned chromosome (chromosome align-
ment.ijm), the selection of each pole is prompted by the macro, ei-
ther manually or automatically. If the user choses to manually select 
the poles, the Multi-point tool (right click on the point tool to select 
multi-point) is used. The macro then initiates the Analyze>Measure 
command to output the centroid coordinate for each pole. Alterna-
tively, if the user chooses the option of automatic detection of the 
poles, the macro initiates the Analyze>Analyze Particles command. 
Once the poles and Range are defined, the four points defining the 
corners of the alignment region are calculated (see below) and the 
resulting polygonal selection created in the image corresponding to 
the kinetochores. Signal from inside the polygon is subsequently 
deleted with the Clear function resulting in an image containing only 
the misaligned kinetochores outside the alignment zone. The kinet-
ochore image is filtered using the set Auto threshold function, fol-
lowed by Make Binary and Watershed. Further manual thresholding 
at the discretion of the user can be implemented to optimize kineto-
chore detection. The number of kinetochores/objects and their po-
sitions are detected with the Analyze Particles function. As with 
thresholding, the parameters for the Analyze Particles function can 
be additionally optimized by the user. The final output from the 
macro is a summary table with the number of misaligned kineto-
chores as well as their average size and a second table with a de-
tailed description of each kinetochore identified including the area 
and position.

For measuring kinetochore distances away from the metaphase 
plate (kinetochore to metaphase distance.ijm), the selection of each 
pole is performed as described in the previous paragraph following 
the parameters inputted by the user for the Range. The image is then 
filtered through Process>Filters>Convolve and Image>Adjust>Thresh

old>MaxEntropy dark, followed by the detection of kinetochores 
with the Analyze Particles function. The shortest distances of individ-
ual kinetochores from the metaphase line are calculated (see below), 
and the final output are two windows: the first table contains the 
kinetochore identification number and its distance to the metaphase 
plate, and the second table lists the distance between the poles.

Finally, in the macro to identify lagging chromosomes in ana-
phase cells (lagging chromosomes.ijm), the desired cell is selected 
and the exterior is deleted as indicated above. Note that for the 
purpose of this macro, the background needs to be black which can 
be set under image>color>color picker. The coordinates at the cen-
troids of the two anaphase chromosome masses can be selected 
manually using the Multi-point tool as indicated above in the image 
of the chromatin signal. Alternatively, the center of the anaphase 
chromosome masses is determined automatically by selecting the 
first mass, excluding the exterior image with Clear, and then using 
the Threshold function and Create selection to create a selection 
containing the first anaphase chromatin mass. The Measure func-
tion will then output the centroid coordinates corresponding to the 
center of the chromatin mass. The same procedure is repeated in 
the macro for the second chromatin mass. After obtaining both co-
ordinates and providing Range parameters, the polygon can be 
calculated and in the kinetochore image with the built-in Polygon 
function. The function Clear outside is then used to exclude all sig-
nal apart from the kinetochores inside the “lagging region” defined 
by the polygon. The kinetochores are counted with the Analyze 
particles function as indicated above for measuring chromosome 
alignment. The output includes a table with the number of lagging 
chromosomes, total area, and average size, and a second table lists 
the area and position of the chromosome masses.

Mathematical deductions
To determine the coordinates of the spindle, the cell is interpreted 
in a Cartesian plane. Given the two poles where (xP1, yP1) and 
(xP2, yP2) represent the coordinates of the first and second spindle 
poles, respectively, the equation of the line that passes through the 
poles (i.e., spindle line) is represented by:

= +y a x bspindle spindle

Where the slope of the spindle line (aspindle) is given by the 
equation:

a
y y

x x
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Using this equation, aspindle is calculated and is then used to 
determine the slope of the metaphase line ( a ) which is 
perpendicular:
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To define the alignment zone, the Range parameters are user-
defined as follows:

=Range
Aligned segments

Total segments

where aligned segments indicate the number of central segments 
that constitute the alignment zone and total segments are the total 
number of segments that the area between the spindle poles is di-
vided into. The offset factor (F, see Figure 2C) defines the points 
along the spindle line that demark the boundaries of the alignment 
zone and is a function of the Range. Thus:
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F
Range1

2 2
1 = −

F
Range1

2 2
2 = +

These functions are then used to determine the points on the 
spindle line through which the alignment lines pass, as follows:

x y x F x x y F y y( ; ) ;P P P P P P1 1 1 1 2 1 1 1 2 1( )( )= + − + −

x y x F x x y F y y( ; ) ;P P P P P P2 2 1 2 2 1 1 2 2 1( )( )= + − + −

With the deduction of the two points delimiting the alignment 
region and the slope of the metaphase line, the equation of the 
alignment lines can be determined as in Figure 3C. Given that 
these lines are parallel to the metaphase line, their slope can be 
represented by a. Thus, the two alignment lines that determine the 
width of the alignment region are defined by the following 
equations:

y ax b1= +

y ax b2= +

where

b y ax1 1 1= −

b y ax2 2 2= −

Next, the four points on the alignment lines that limit the outer 
corners of the alignment polygon are deduced (Figure 3, D and E). 
If a > 0, then xr1; yr1 is set to 0; b1; xr1 set at 0 signifies the limit of 
the image in the Cartesian plane, where it intercepts the y-axis 
(Figure 3D).

x y b( ; ) 0;r r1 1 1=

The second coordinate (xr2; yr2) is the closest point on the paral-
lel alignment line. This is calculated by:

x y
x ay ab
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ax y ab
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By applying the above equation, xr2; yr2 is defined:
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The third point is defined by the upper limit of the y-axis in the 
Cartesian plane. In the macro, this is set to 15,000 pixels by default. 
Thus, the third point is calculated as:

x y
y b

a
y( ; ) ;r r

limit
limit3 3

1=
−

The fourth and final coordinate can be calculated by determining 
the closest point on the second line to xr3; yr3 as above:

x y
x ay ab

a
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If a < 0, then xr1; yr1 is set to xr1; 0 (Figure 3E). By applying the 
equation of the line above:

x y
b

a
( ; ) ;0r r1 1

1= −

The remaining points of the alignment polygon are subsequently 
calculated as above.

Finally, to calculate the distance of individual kinetochores away 
from metaphase line, the shortest distance between kinetochores 
and the metaphase line needs to be computed. To this end, the 
metaphase line is defined as:

y ax bmetaphase= +

The midpoint, which is the point at which the spindle and meta-
phase lines intersect, is then calculated and used to determine the 
metaphase line. Thus:

x y x
x x
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and

b y axmetaphase middle middle= −

Therefore, the distance d of any given point (x, y) reflecting a ki-
netochore position relative to the metaphase line (Figure 4G) can be 
calculated as follows:

d
ax y b

a 1

metaphase

2
=

− +

+
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